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What is Stealth EA? 

Some Forex brokers have a nasty habit of hunting for your stop loss and profit orders with a 

hope to adjust their spreads just at the right time to knock some of its users out of the trade. 

This is known as stop and limit order hunting. The Stealth EA has the ability to hide your real 

stop loss and profit limit from the brokers so they cannot take this action or at least not take it 

at the right time. 

 

This clever little Expert Advisor produces a virtual stop loss and profit order that are represented 

on your chart as colored horizontal lines. If you were ever unsure whether your broker was 

adjusting the spread near your stop loss and profit levels, the Stealth EA will protect you. The 

Stealth EA will hide the stop loss, hide the take profit, and create horizontal lines on the chart. 

These lines can then be moved with your mouse and that is how you modify stop loss and take 

profit easily. 

Important things to know before you use  

Stealth EA 

You must have a Metatrader 4 account in order to use this software. Stealth EA works only on 

Metatrader 4 platform. 

 

Stealth EA software does not trade and make money in Forex market on its own. This software 

has a lot of useful features that will help you in everyday Forex trading. With Stealth EA software 

you can perform various tasks and operations with ease and much faster than manually. Many 

features included in the Stealth EA are not available in any regular MT4 platform. 
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Stealth EA installation using automated installer 

Step One: All program files of Stealth EA are compiled into one executable file and will be 

installed into your chosen Metatrader 4 folders by InstallForex Wizard. To start installation 

please run Stealth EA Personal.exe or other file that you have downloaded. 

 

Step Two: In the pictures below you can see the "Stealth EA" installation example. After 

Stealth EA setup wizard is loaded it will scan your computers' "Program Files" folder to find out 

where your Metatrader 4 platforms are located. Then please click NEXT to get to the next 

window where you will be able to choose where to install the software. 
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Step Three: You can choose as many destination folders as you like. Setup wizard will install 

software into all selected folders. If your MT4 is not on the list, please use BROWSE button to 

add it. Click NEXT to get to the next window where setup wizard will install software files and 

give you detailed info on what files were copied to your computer. To continue click NEXT. 

 

 

Step Four: Once you get to the last setup wizard window please click FINISH. 
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Step Four: Launch your Metatrader 4 platform then open your Navigator window (View -> 

Navigator or CTRL-N). Under "Expert Advisors" you will see Stealth EA and under the "Scripts" 

you will find extra tools. Click and drag them from the Navigator window to an open chart to 

run. 
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EA Properties - Common Tab 

When you run EA or script please make sure the following are set correctly: 

1. Make sure that Allow live trading is checked  

2. Make sure that Ask manual confirmation is “NOT” checked 

3. Make sure that Allow DLL imports is checked 

4. Make sure that Confirm DLL function calls is “NOT” checked 

 

 
 

On your Metatrader toolbar, make sure that Experts Advisors is turned on (green): 

 
 

Step Five: Close Metatrader and re-open to make sure EA starts running on startup. If you 

need your MT4 platform to work online 24/7 or your internet connection is unreliable, you 

should consider purchasing this low cost Virtual Private Server (VPS). You can use promo code 

EACODER to get a 15% discount. 

 

 

http://www.vpsforextrader.com/
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Running Stealth EA for the first time 

Every time you start the Stealth EA you will need to input your License Key. It was sent to your 

email right after the purchase. 

 

 
 

When Stealth EA is attached to the MT4 chart for the first time it will activate the license on your 

computer. A simple message saying "License activated" should come up.  

 

 
 

After you click OK it will disappear and EA will start working. Once the license is activated it will 

be locked to your computer. If you own a "single computer license" the EA can be used on a 

single computer at the same time. If you own "unlimited computer license" EA can be used on 

multiple computers at the same time. Please refer to the website for detailed explanation about 

license types. 
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You can always transfer the license to another computer. Simply run the EA on another 

computer and answer YES when you will be asked to transfer the license. 

 

 
 

You can always access EA Inputs window by pressing F7 on your keyboard or choosing Expert 

Advisors -> Properties in the popup menu of the chart (click right mouse button to open 

menu). 
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How to use Stealth EA? 

1) Once started, the EA will try to remove (set to zero) the real stop loss and take profit 

levels from every trade if you enabled this feature with RemoveInitialStops=true setting. 

If you set UseInitialStops=true, SL and TP levels would be  converted to virtual levels 

and stored in Tools -> Global Variables (F3). Current chart trades will have horizontal 

lines drawn, that will act as SL and TP and help you see where the levels are on the 

screen. It is wise to have  a bit smaller virtual SL and TP than initial stops so the trades will 

be closed before it hits initial stops. This way you can fool your broker. 

2) If you have UpdateStopsOnMouseDrag enabled then EA will update SL and TP levels 

when you move the lines with your mouse. Just double-click your left mouse button to 

select the line and drag it anywhere you want. 

3) If you drag horizontal line too close or beyond the price your trade may be closed as EA 

will think it hit SL or TP. For example if you have BUY with TP line at 1.2600 and current 

market price is 1.2500. Now, if you drag TP line down to 1.2499, it means that the trade 

hit TP and EA will close it. 

4) You can set EA to manage only current pair trades (default) or any pair trades. It means 

that if you run EA on EURUSD, by default the EA will manage only EURUSD trades. But 

you can set the EA to manage all trades regardless what currency pair it is. 

5) Additionally you can set a specific magic number so EA will manage only the trades with 

the magic number you set. It is useful when you want EA to manage trades of a 3rd party 

EA. 

6) Normally BUY trades are closed at BID price, and SELL trades are closed at ASK price. 

Now when brokers widen the Spread your SELL trade may be stopped out. This EA can 

ignore Spread, and it means that BUY trades will be closed at ASK price, and SELL trades 

will be closed at BID price. So now when brokers widen the spread your SELL trade may 

survive because only ASK price reached the stop loss level, not the BID price. Note that 

ignoring spread may give you a bigger loss in money and pips. If your broker widens the 

spread by 30 pips (instead of normal 3 pips) your trade can experience 30 pips bigger 

loss or 30 pips lower profit. 

7) You can configure your MT4 to show the trade ticket number with every SL and TP line 

drawn on the chart. To turn this feature on you need to check the "Show object 

descriptions" box in the chart properties window (F8) "Common" tab. This will also show 

"buy" and "sell" with the hidden pending order lines. 

8) Stealth EA has advanced protection built-in against the stop loss and take profit levels 

loss. These values are stored as horizontal lines on the chart and as global variables in the 

MT4 memory. If you close Stealth EA or MT4 or your MT4 crashes, EA will restore all 

hidden SL/TP values on the next launch. However, this behavior may be unwanted if you 

want to change hidden SL/TP values by setting new EA inputs as the new SL/TP values 

you set will not take effect. Normally you would not want EA canceling all SL/TP values 

for the trades, especially when you have a breakeven or trailing stop already active on 

some trades. But if you need new SL/TP values to be applied, please run the script STOPS 

RESET found under Scripts in the Navigator window (Ctrl+N) after you change EA 

inputs with the new SL/TP values. 
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9) With the release of Stealth EA v2.2, you can now set "fake" real stops. You can set 

distance in pips where fake stop loss or fake take profit will be set on the trade. The 

"fake" SL/TP values will be visible to broker, but your "real" hidden SL/TP will actually be 

smaller. Because of this trade will be closed at hidden SL/TP before hitting "real" stop 

loss. When the market is very fast, "real" SL/TP will protect you from unexpected losses. 

Also, this is very useful if your MT4 or the computer crashes, you will still be protected by 

real SL/TP. 
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Hidden Pending Orders 

Stealth EA gives you the ability to use hidden pending orders. These are the horizontal lines that 

you place on the chart with the proper commands in the description value. Once the market 

price touches the line, EA will immediately open the market order according to the commands 

that you have put in the description of the line. 

 

To place hidden pending orders you need to draw a horizontal line on the chart manually using 

MT4 drawing tools and set appropriate description text. Please refer to MT4 manual to learn 

how to draw lines on the chart, but basically it is done from the menu Insert -> Lines -> 

Horizontal Line. 

 

You can place "hidden" BUY and SELL pending orders. After you draw a horizontal line on the 

chart, please open the line properties window. In the "Description" field enter appropriate text 

that will tell EA what trade to open and what parameters to use. All parameters are separated 

with a semicolon ";" and there must be at least one value either "buy" or "sell". 

 

Please note that there is a limit of how many characters you can input in the description field. 

Max description text length is 62 characters. The rest will be trimmed automatically by MT4. 

 

Here, are the list of available parameters for „hidden pending order line“: 

A. Trade type (should be simple text (buy or sell) and it should come first. 

B. id=[number]; ID of the hidden pending order. It can be unique for each 

line or you can create individual group of lines using the same ID numbers. 

This number is used by OCO function to cancel the hidden pending order 

when the opposite order is triggered (see below). 

C. size=[number]; Lot size, risk in percent (%) or risk by the amount of money 

($).  

If not found EA will use money management settings from the EA inputs. 

D. sl=[number]; Stop loss in pips (if not found EA will use StopLossPips) 

E. tp=[number]; Take profit in pips (if not found EA will use TakeProfitPips) 

F. vf=[time]; "Valid from" time. EA uses 24 hour format like "hh:mm".  

Example: vf=14:58 

Example: vf=2012.09.20 15:02 

If you enter only time and no date, EA will use today's date. If you enter 

only date and no time, EA will use 00:00. 

G. vt=[time]; "Valid till" time. EA uses 24 hour format like "hh:mm". 

Example: vt=16:49 

Example: vt=2012.09.21 11:00 

If you enter only time and no date, EA will use today's date. If you enter 

only date and no time, EA will use 00:00. 

H. oco=[number1,number2,number3,...]; This is where you can set the list of 

hidden pending order ID numbers that EA must remove if this order will be 

triggered. You can set an ID number of a single order or enter a comma 
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separated list of ID numbers if you want multiple orders to be removed. 

This works even if you have OCO=false in the EA inputs. 

I. bes=[number] and bem=[number]; These two variables represent the 

BreakEvenStartPips and BreakEvenMovePips for individual orders. It means 

that each trade can have its own break even option. If those are not set, EA 

will use break even settings from EA inputs. 

Example 1: buy;size=0.1;sl=20;tp=10 

When price reaches horizontal line with the description set in example 1, EA will open 

BUY trade of 0.1 lot size, hidden stop loss of 20 pips and hidden take profit of 10 pips. 

Example 2: sell;size=2%;sl=50; 

When price reaches horizontal line with the description set in example 2, EA will open 

SELL trade. Lot size will be calculated automatically according to your current account 

equity, risk of 2% and stop loss of 50 pips. Note that stop loss is a must in this situation; 

otherwise EA will not be able to calculate lot size. If you would set stop loss to zero, EA 

will delete this hidden trade entry line and trade will not be opened. Trade will have 

default hidden take profit set by TakeProfitPips (because we have set it to zero) and 

hidden stop loss of 50 pips. 

Example 3: buy;size=$5000;sl=50;tp=200;vf=11:00;vt=17:00 

When price reaches horizontal line with the description set in example 3, EA will open 

BUY trade. Lot size will be calculated automatically risking your preset amount of money, 

in this case it is $5000. Hidden stop loss of 50 pips will be used. Note that stop loss is a 

must in this situation; otherwise EA will not be able to calculate lot size. If you would set 

stop loss to zero, EA will delete this hidden trade entry line and trade will not be opened. 

Trade will have take profit of 200 pips and will be valid only from "11:00" (broker time). If 

the price touches the line before "11:00" the order will not be filled. Order is set to expire 

at "17:00", and if it will not be filled until that time EA will cancel the order. The lot size 

will be 10.0, and in case the trade hit stop loss of 50 pips we lose $5000. Note that 

regardless what type of account you have, EUR, GBP, JPY or some other deposit currency 

account, you will still need to use a dollar sign ($) for this value. 

Example 4: buy;vf=2012.09.21 08:00;vt=2012.09.21 17:00; 

This example was created on 2012.09.20. We have set "hidden" BUY pending order for 

tomorrow. It will be valid on 2012.09.21 from 08:00 till 17:00. If order is not filled by that 

time it will be cancelled. 

Example 5: Four hidden pending orders created 

buy;id=1;size=0.02 

buy;id=2;size=0.04;oco=4 

buy;size=0.06 

sell;id=3;oco=1,2 

sell;id=4;oco=2 

This example shows how you can create multiple hidden pending orders and set them to 

cancel other orders. It does not have to be opposite orders, you can set any ID number 

you need to remove. In this example: 

 When SELL order #3 will be triggered it will remove the lines with the IDs #1 & #2 

 When SELL order #4 will be triggered it will remove the line with an ID number #2 

 When BUY order #1 will be triggered it will not remove any orders 
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 When BUY order #2 will be triggered it will remove the line with an ID number #4 

 

If "sl", "tp" or "size" parameters are missing, EA will simply use default values from EA 

inputs. This means that if lot size ("size") is missing in the "line description text" EA will 

use FixedLotSize or Risk_Percent. If the "sl" and "tp" values are missing, EA will use 

StopLossPips and TakeProfitPips respectively. "vf" and "vt" can be set only in the line 

description. 

 

If you set the right description of the horizontal line, EA would set their colors to 

NewBuyTradeLineColor or NewSellTradeLineColor. If you set incorrect line description, 

EA will delete the line from the chart or set its color to UnusedLineColor. 

Once trade is executed the line will be removed from the chart. 

Note that EA will use MagicNumber value when opening hidden pending orders. You 

may want this number to match ManageMagicNumber if it is greater than zero. 
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Close Orders by vertical lines 

With the release of Stealth EA v2.4, you can now create vertical lines that will instruct EA to 

close certain orders. You need to drawn a vertical line on the chart manually using MT4 

drawing tools and set appropriate description text. Please refer to MT4 manual to learn how 

to draw lines on the chart. After you draw a vertical line on the chart, please open line 

properties window. In the "Description" field enter appropriate text that will tell EA what 

order(s) to close and what parameters to use. All parameters are separated with a semicolon 

";" and there must be at least one value "close". The closing time depends on the time where 

the line is drawn at. If you draw a line at "2012.09.24 06:54" EA will close particular orders 

when that time comes. You can close orders by type (buy, sell, buy limit, sell limit, buy stop, 

sell stop), by magic number, trade comment and by a pair. 

 

When you draw the "close line" on chart, please draw it "in the future". It is the space on the 

chart where no candles are. If you draw the line "in the past", EA will activate it immediately, 

close the corresponding trades and remove the line from the chart. 

 

If you want to set "close time" that is not visible on chart, please switch to a higher time 

frame or enter exact time in the "vertical line" properties window, in the "Parameters" tab. 

 

Here is the list of available parameters for „close order line“: 

A. type=[text]; order type should be a simple text like buy, sell, buy limit, 

sell limit, buy stop or sell stop. If this parameter is missing, EA will close 

any order. 

B. magic=[number]; Magic number, if this parameter is missing EA will use 

ManageMagicNumber value from the EA inputs. 

If you set magic=-1, EA will ignore ManageMagicNumber and close all 

open trades with any magic number. If you set magic=0, EA will close all 

manually open trades only (the ones with the zero magic number). 

C. comment=[text]; Trade comment, if this parameter is missing EA will 

ignore trade comment. Otherwise, EA will close only order that contain this 

specified text. Note that you can not use semicolon ";" 

D. pair=[text]; Currency pair (chart symbol), if this parameter is missing EA will 

close orders only of a current pair. 

Set pair=all to close orders of any pair. 

Set pair=EURUSD to close EURUSD orders only. 

E. ticket=[number]; Trade ticket number, if this parameter is set, EA will 

ignore all other parameters and will close the exact trade identified by trade 

number. 

Example 1: close;type=buy 

When the time comes that this vertical line is reached, EA will close BUY orders using 

ManageMagicNumber value from the EA input, but only on the current pair (chart symbol). 

By default, it is any magic number and current chart pair (symbol). It means EA will close all 

BUY orders that run on the current chart with a specified magic number only. 
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Example 2: close;type=sell;pair=GBPUSD; 

When the time comes that this vertical line is reached, EA will close GBPUSD SELL orders 

using ManageMagicNumber. By default, it is any magic number. It means EA will close all 

SELL orders that run on any GBPUSD chart. 

Note that you need to use exact pair name. If your broker use currency pair suffix like 

GBPUSDlh or GBPUSDFXF, you would need to use pair=GBPUSDlh and pair=GBPUSDFXF 

respectively. If you set pair=any EA will close orders of any pair. 

Example 3: close;type=sell;pair=any; 

When the time comes that this vertical line is reached, EA will close all SELL orders running 

on any pair (chart) using ManageMagicNumber. By default, it is any magic number. It means 

EA will close all SELL orders that run on any chart. 

Example 4: close;comment=MyEA system #1;magic=22736 

When the time comes that this vertical line is reached, EA will close all orders that have the 

magic number 22736 and trade comment contains "myea system #1" text (case insensitive). 

As you may have noticed, this looks like some custom EA open trades using specified magic 

number and uses trade comment with the trading system ID. Stealth EA allows you to filter 

trades opened only by this custom EA, when it uses trading system #1. 

Example 5: close;type=buy;ticket=1188276 

When the time comes that this vertical line is reached, EA will close order by ticket number 

#1188276. Value "type=buy" and any other set parameters will be ignored. This order can be 

of any type, magic number and run on any pair. EA will ignore all of this info and identify it 

only by ticket number. 

 

If "type", "magic", "comment" or "pair" parameters are missing - EA will simply ignore them 

or use default values from EA inputs. This means that if the magic number ("magic") is 

missing in the "line description text" EA will use ManageMagicNumber. If the "type" value is 

missing, EA will close orders of any type. If the "comment" value is missing, EA will ignore 

trade comments. If the "pair" value is missing, EA will use current pair (chart symbol). 

 

If you set the right description of the vertical line, EA would set line color to 

CloseTradeLineColor. If you set incorrect line description EA will delete the line from the 

chart or set its color to UnusedLineColor. 

Once trade is executed the line will be removed from the chart. 
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Timed Orders by vertical lines 

With the release of Stealth EA v2.5, you can now create vertical lines that will instruct EA to 

open orders at a specified time. You need to drawn a vertical line on the chart manually 

using MT4 drawing tools and set appropriate description text. Please refer to MT4 manual to 

learn how to draw lines on the chart. After you draw a vertical line on the chart, please open 

line properties window. In the "Description" field enter appropriate text that will tell EA what 

order should be opened and what parameters to use. All parameters are separated with a 

semicolon ";" and there must be at least one value either "buy" or "sell". The opening time 

depends on the time where the line is drawn at. If you draw a line at "2013.10.14 12:54" EA 

will open particular order when that time comes. You can open market orders this way by 

using mostly the same settings as for the hidden pending orders. „Timed Orders“ are kind of 

the same as hidden pending orders, but they are activated at a certain time instead of a 

certain price. This of them as of hidden market orders. 

 

When you draw the "timed order line" on chart, please draw it "in the future". It is the space 

on the chart where no candles are. If you draw the line "in the past", EA will activate it 

immediately, thus means EA will open the corresponding trade and remove the line from the 

chart. 

 

If you want to set "entry time" that is not visible on chart, please switch to a higher time 

frame or enter exact time in the "vertical line" properties window, in the "Parameters" tab. 

 

Here is the list of available parameters for „timed order line“: 

A. Trade type (should be simple text (buy or sell) and it should come first. 

B. id=[number]; ID of this order. It can be unique for each line or you can 

create individual group of lines using the same ID numbers. This number is 

used by OCO function to cancel the hidden pending order when the 

opposite order is triggered (see below). 

C. size=[number]; Lot size, risk in percent (%) or risk by the amount of money 

($).  

If not found EA will use money management settings from the EA inputs. 

D. sl=[number]; Stop loss in pips (if not found EA will use StopLossPips) 

E. tp=[number]; Take profit in pips (if not found EA will use TakeProfitPips) 

F. vt=[time]; "Valid till" time or time when the trade should be closed. Once a 

trade is opened and „vt“ option is present, EA will create a „close line“ for 

that time. EA uses 24 hour format like "hh:mm". 

Example: vt=16:49 

Example: vt=2012.09.21 11:00 

If you enter only time and no date, EA will use today's date. If you enter 

only date and no time, EA will use 00:00. 

G. oco=[number1,number2,number3,...]; This is where you can set the list of 

hidden pending/market order ID numbers that EA must remove if this order 

will be triggered. You can set an ID number of a single order or enter a 
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comma separated list of ID numbers if you want multiple orders to be 

removed. This works even if you have OCO=false in the EA inputs. 

H. bes=[number] and bem=[number]; These two variables represent the 

BreakEvenStartPips and BreakEvenMovePips for individual orders. It means 

that each trade can have its own break even option. If those are not set, EA 

will use break even settings from EA inputs. 

For examples please refer to the „Hidden Pending Orders“ section. 

 

If "sl", "tp" or "size" parameters are missing, EA will simply use default values from EA 

inputs. This means that if lot size ("size") is missing in the "line description text" EA will 

use FixedLotSize or Risk_Percent. If the "sl" and "tp" values are missing, EA will use 

StopLossPips and TakeProfitPips respectively. "vt" can be set only in the line 

description. There is no "vf" option for „Timed Orders“ because vertical line time 

represents order entry time. 

 

If you set the right description of the horizontal line, EA would set their colors to 

NewBuyTradeLineColor or NewSellTradeLineColor. If you set incorrect line description, 

EA will delete the line from the chart or set its color to UnusedLineColor. 

Once trade is executed the line will be removed from the chart. 

Note that EA will use MagicNumber value when opening hidden pending orders. You 

may want this number to match ManageMagicNumber if it is greater than zero. 

1-Click trading with the Stealth EA 

Stealth EA can open market orders immediately with one button click. This can be achieved in 

two ways: 

1) You can double click your left mouse button on the BUY NOW or SELL NOW scripts to 

open trades immediately. Stealth EA must be running at that time. 

2) You can set special hotkeys like Alt+2 and Alt+3 on BUY NOW and SELL NOW scripts. 

Then, by clicking these hotkeys, you will be able to open market orders immediately. Lot 

size and hidden stop loss/take profit values must be set in the Stealth EA settings. 

 

Note that EA will use MagicNumber value when opening such trades. You may want this 

number to match ManageMagicNumber if it is greater than zero. 

How to set hotkeys for BUY NOW and SELL NOW scripts? 

Click the right mouse button on the script you want to set hotkey for and choose "Set hotkey". A 

new window, "Navigator Hot Keys", will open. In this window, make sure your script is 

highlighted. Now double-click the "Control" column for your script and chose the "Alt" or 

"Control" key. Next, double-click the "Key" column for your script and enter the key you want to 

use. We recommend Alt+2 for BUY NOW script and Alt+3 for SELL NOW script. 
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Stealth EA settings 

LicenseKey - this is where you need to enter your license key. Normally it is automatically 

delivered by email right after the purchase. 

 

StealthMode - if this value is set to true EA will use hidden stops; otherwise EA will only wait 

until the time comes to close the trades at CloseAllTradesTime. 

 

UseInitialStops - if this value is set to true EA will use initial trade stop loss and take profit if 

any exist. Additionally, if you set RemoveInitialStops=true EA will try to remove (set to zero) 

real stop loss and take profit level from every trade and convert them to virtual levels that are 

stored in Tools -> Global Variables (F3). InitialStopsMultiplier allows you to have smaller 

virtual SL and TP than the real stops. By default, it is set to 0.8, and that means your virtual stops 

will be 80% of the initial stops. Current chart trades will have horizontal lines drawn on the 

screen that will act as SL and TP and help you see where the levels are. If you set this value to 

false EA will leave real SL and TP as is and additionally create hidden SL and TP levels. This way 

you can fool your broker that you have SL and TP, but actually you will use smaller SL and TP 

that are hidden and broker can not see them. 

 

UpdateStopsOnMouseDrag - if this value is set to true, EA will update SL and TP levels when 

you move the lines with your mouse. Just double-click your left mouse button to select the line 

and drag it anywhere you want. Obviously this can be done only on the chart where EA is 

running. 

 

ManageMagicNumber - if this feature is set to -1, EA will manage all trades on the current 

chart; otherwise it will manage only the trades with the magic number specified. This is very 

useful when you want to hide stop loss and take profit of trades from another EA and ignore 

manually opened trades. Note that if this value is set to zero, the EA will manage only manually 

opened trades (the ones with the zero magic number). 

 

ManageOnlyCurrentPair - if this feature is set to true, EA will only manage trades of the 

current chart currency it is running on. "Close lines" ignore this setting. 

 

TakeProfitPips and StopLossPips - these are the default hidden take profit and stop loss 

values. If UseInitialStops=true EA will use initial SL & TP. If any of the initial stops are empty, EA 

will use default stop values. 

 

TakeProfitMoney and StopLossMoney - these are the additional take profit and stop loss 

values in money. EA will use account deposit currency for calculations. When trade reaches 

profit or loss of those values it will be closed. No lines will be displayed for these stops. Set 

these to zero to disable. 

 

TrailStopStartPips and TrailStopMovePips - EA will activate Trailing Stop function when trade 

goes in profit by pips value set in TrailStopStartPips. Once activated, EA will move stop loss in 
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profit by pip step set in TrailStopMovePips. The trailing stop works like a ratchet. If it is set to 

TrailStopStartPips=55 pips and TrailStopMovePips=10, it will follow 55-10=45 pips behind as 

price moves, but doesn't give any back if price comes back at you. Although it is activated only 

when the trade gets into profit of 55 pips. 

 

BreakEvenStartPips - sets how many pips trade should get into profit before stop loss is 

moved to the entry price. BreakEvenMovePips is used to set how many pips EA must add to 

the entry price if you want your trade to be closed in profit on reverse. Breakeven is applied only 

once. Say you have BreakEvenStartPips=55 and BreakEvenMovePips=2. When the trade goes 

into profit of 55 pips. Then the stop loss will be moved to OPEN_PRICE+2 pips. 

 

CloseAllTradesTime - this is where you set the time when EA should close all trades. This 

feature is active if you will set CloseAllTradesOnTime=True. Additionally you can set the magic 

number to match (CloseAllTradesByMagicNumber) when closing trades using this option. 

 

CloseAllTradesByMagicNumber – This option is used with the CloseAllTradesOnTime option 

only. If this value is set to -1, the EA will close all trades of the current currency pair (unless 

configured differently). If this value is set to zero, the EA will close only manually opened trades 

(the ones with the zero magic number). If this value is set above zero, the EA will use that magic 

number to find the running trades and only close those that match. 

 

UseMoneyManagement - if this feature is set to true EA will use special function to calculate 

lot size. Otherwise, it will use FixedLotSize value. Use Risk_Percent variable to set risk in 

percent. It is calculated using stop loss. These values are used only for opening trades by BUY 

NOW and SELL NOW scripts. 

 

FakeRealStops - set this to TRUE to set real stop loss and/or take profit on the trade. It is wise 

to set it to be bigger than hidden SL/TP, this way broker will be fooled by this fake SL/TP 

because EA will close trade earlier at the hidden SL/TP value. You can control the distance in 

pips of the fake, real, SL/TP from the hidden SL/TP value by using EA settings named 

FakeRealSLDistancePips and FakeRealTPDistancePips. By default, these are set to 20 pips, so 

if your hidden SL is 30 pips, the real SL will be set to 50 pips. Set values(s) to zero to disable real 

SL and/or TP. 

 

OCO - One-Cancels-Other. If set to true EA will cancel opposite hidden pending orders when 

the first one is triggered. This means that EA will remove all horizontal lines from the chart of the 

opposite pending orders. If you have "buy" and "sell" hidden pending orders on the chart and 

one of them is filled, the other one will be removed. This does not affect real pending or real 

market trades. By default, this value is set to false, and that means this feature is disabled. Note 

that you can override this by setting special horizontal line description text that contains "oco=" 

variable and this works even if you have OCO=false. 

 

CloseOppositeTradeBeforeOpen - if this value is set to TRUE, EA will close opposite trade(s) 

automatically when you send "open a trade" signal using BUY NOW or SELL NOW scripts. By 
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default, it is set to TRUE and EA is not allowed to open hedge positions, it means have BUY and 

SELL trades at the same time.  

 

StopLossLineColor, TakeProfitLineColor, NewBuyTradeLineColor and 

NewSellTradeLineColor - this is where you set color of the hidden stops lines and hidden 

pending order lines. If set to NONE the lines will be hidden. 

 

CloseTradeLineColor - this is where you set color of the "close trade" lines. When the "close 

trade" line is detected by the EA, it will set line color to this value. 

 

UnusedLineColor - this color will be used in case you set incorrect values for the horizontal or 

vertical lines. If the line color is set to this value, it means EA did not recognize the line. Note 

that this works only when DoNotTouch3rdPartyLines is set to false. 

 

DoNotTouch3rdPartyLines – if you are using 3rd party indicator/EA on the same chart with the 

Stealth EA, it may remove or change color of the lines created by those 3rd party apps. To stop 

this simply set this value to true. Note that in this case Stealth EA will not change color of the 

incorrectly set lines as described in UnusedLineColor option. 

 

MagicNumber - this is where you choose what magic number must be set for the trades that 

EA will open using hidden pending orders and BUY NOW or SELL NOW scripts. You may want 

this number to match ManageMagicNumber if it is greater than zero. 

 

MaxSpreadPips - set a maximum allowed spread. If the spread is higher than this value, at the 

moment of the trade opening, EA will skip the trade and the entry line will be removed from the 

chart. 

 

IgnoreSpread - if this value is set to true EA will ignore the spread. Normally BUY trades are 

closed at BID price, and SELL trades are closed at ASK price. Now, when brokers widen the 

spread, your SELL trade may be stopped out.  If the spread is ignored, BUY trades will be closed 

at ASK price, and SELL trades will be closed at BID price. So now when brokers widen the spread 

your SELL trade may survive because only ASK price reached the stop loss level, not the BID 

price. Note that ignoring spread may give you bigger loss in money and pips. If your broker 

widens the spread by 30 pips (instead of normal 3 pips) your trade can experience 30 pips 

bigger loss or 30 pips smaller profit. 

HideLogo - this setting hides logo from the bottom-right corner if set to TRUE. 

SilentMode – if you want EA to not show any popups and messages on the chart, you need to 

set this value to true. In this mode all warning and error messages will be only printed in the 

„Experts“ tab at the bottom of your MT4 platform. 

 

DashboardDisplay - this setting controls how you want EA to display the dashboard (Blue Box). 

If this value is set to 0 (zero), EA will not display the dashboard. If you set this value to 1, EA will 

display the dashboard without background. If you set this value to 2, EA will display the 

dashboard with the background set by DashboardColor and our company logo at the bottom-
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right corner. To display dashboard on top of the chart bars, you may need to uncheck "Chart on 

foreground" box in the chart properties window (F8) "Common" tab. 

Dashboard and logo position on screen were chosen wisely. 

 Notice that the dashboard is aligned to the left but there is space left. This space is 

reserved for your trade ticket numbers. Notice that when you open trade, the MT4 

platform displays trade type (buy/sell) and ticket number at the left of the chart. This is 

why the dashboard is moved a bit to the right to not cover that information.  

 Vertical alignment of the dashboard is set to the top, but there is some space left. This is 

where EA will display critical errors in red, bold text. This  ensures you will not miss any 

critical errors. 

 Company logo is displayed in the bottom-right corner. If you enable "Chart Shift" your 

chart will be moved away from the right border, and logo will not cover your chart price. 

If you enable "Chart Shift" feature it will be easier to read the chart and indicators. Also, 

many other 3rd party indicators and EAs use that space to display various info in the top-

right corner. 
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Important and other information 

You should be aware that different brokers have different price feeds, spread, stop levels, etc. In 

some cases broker servers give errors like price re-quotes, delays, timeouts and trade context 

busy errors. Although Stealth EA is designed to handle these errors you should be aware that it 

still could lead to some trades not being opened, modified or closed. 

 

If you want to report any issue with the EA or script, please contact support and do not forget to 

include log files from \Your-Mt4-Folder\experts\logs\ and a screen shot of your chart with the 

EA running if that is possible. 

 

What is slippage? 

The short answer is that slippage is what happens between the time you close/place an order to 

buy or sell a currency and the time that your order is filled, i.e., the time that the transaction is 

completed.  In most cases, in a fast-moving volatile market such as EUR/USD (Euros and US 

Dollars), from the time you place an order until the time it is filled the exchange rate will often 

change anywhere from $.0002 to $.0003 from the price you saw and wanted to get when you 

placed your order, even with the fastest automatic electronic ordering software.  If you are 

trading by hand, i.e., sending your order to your broker via a non-automatic signal generating 

platform, then you can expect slippage to be as much as $.0010 to $.0015! The same is applied 

when you are closing the trade or deleting pending order. 

 

What is "Stop Level" or "Minimum Distance Limitation"? 

The "Stop Level" is the minimum distance limitation between the market price and entry/stop 

price. This value is different among brokers like the Spread value. The "Stop Level" value can be 

variable as well; it means that it can be changed by your broker during news releases. 

This value is controlled by your broker and can not be changed. 

Example: if your account has "Stop Level" set to 6 pips, it means that stop loss, take profit or 

entry price should be set at least 6 pips from the current market price. Any SL, TP, entry price, 

closer to current market price than 6 pips, will be denied by your broker. 

 

The StopLevel limitation is explained on MQL website http://book.mql4.com/appendix/limits  

Please look for "StopLevel Minimum Distance Limitation" on that webpage. 

http://book.mql4.com/appendix/limits
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 Trading foreign exchange on margin carries a high level of risk and may not be 

suitable for all investors. The high degree of leverage can work against you as well 

as for you. Before deciding to invest in foreign exchange, you should carefully 

consider your investment objectives, level of experience, and risk appetite. The 

possibility exists that you could sustain a loss of some or all of your initial 

investment, and  you should not invest money that you cannot afford to lose. You should be 

aware of all the risks associated with foreign exchange trading, and seek advice from an 

independent financial advisor if you have any doubts. 

Disclaimer of Use 

To the maximum extent permitted by applicable law, in no event shall Ea-Coder.com Software, 

or its suppliers be liable for any special, incidental, indirect, or consequential damages 

whatsoever (including, without limitation, damages for loss of business time, business profits, 

business information, or any other kind of loss) arising out of the use of, or inability to use the 

Software, or failure to provide support services, even if Ea-Coder.com Software, or one of its 

supplies have been advised of the possibility of such damages. Ea-Coder.com Software’s entire 

liability shall not exceed the price paid for the software. Ea-Coder.com will not be liable for any 

claims of loss, financial or otherwise, resulting from the use of software. 

 

Ea-Coder.com does not sell or provide any Forex trading advise - Ea-Coder.com sells Forex 

trading tools. Ea-Coder.com never gives false promises that certain software will make huge 

profits on autopilot 24/7 specially without human intervention. 

 


